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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit Control+clic ou clic 
droit selon la configuration 
de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles et Formatage

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Qu’est-ce qu’Impress ?

Impress est le programme de présentation (diaporama) inclus dans LibreOffice. Vous pouvez créer
des diapositives qui contiennent des éléments différents, tels que du texte, des listes à puces ou
numérotées, des tableaux, des graphiques et une large gamme d’objets graphiques comme des
clip-arts, des dessins et des photographies. Impress possède aussi un correcteur d’orthographe,
un dictionnaire des synonymes, des styles de texte et d’arrière-plan.

Ce chapitre contient les instructions, les captures d’écran et les conseils qui vous guideront dans
l’environnement d’Impress pendant que vous concevrez vos présentations. Bien que des créations
plus  délicates  soient  mentionnées  dans  ce  chapitre,  les  explications  pour  leur  conception  se
trouvent dans le  Guide Impress. Si vous possédez une connaissance opérationnelle de la façon
dont  on  crée  des  diaporamas,  nous  vous  recommandons  d’utiliser  le  Guide  Impress comme
source d’informations.

Aller au-delà de diaporamas très simples demande, avec Impress, quelques connaissances sur les
éléments contenus dans les diapositives. Les textes qu’elles contiennent utilisent des styles pour
définir leur apparence. La création de dessins dans Impress et dans le programme Draw contenu
dans LibreOffice sont semblables. Pour ces raisons, nous vous recommandons aussi de lire le
Chapitre 3, Utiliser les styles et les modèles et le Chapitre 7, Débuter avec Draw de ce guide. Vous
pouvez aussi consulter le Guide Draw pour plus de détails sur l’utilisation des outils de dessin.

Démarrer Impress

Vous pouvez démarrer Impress de plusieurs façons décrites dans le Chapitre 1,  Introduction à
LibreOffice.

Quand vous démarrez Impress pour la première fois, l’assistant Présentation peut apparaître. Voir
« Créer  une  nouvelle  présentation  avec  l’Assistant  de  Présentation »  page  16.  Sinon  la
fenêtre principale d’Impress s’affiche.

Vous  pouvez  activer  ou  désactiver  l’assistant  de  Présentation  dans  Outils  >  Options  >
LibreOffice  Impress > Général  >  Nouveau document en  cochant  ou en décochant  l’option
Démarrer avec l’assistant.

La fenêtre principale d’Impress

La fenêtre principale d’Impress (Figure 1) possède trois parties : le volet Diapo, l’espace de travail
et le volet latéral. En supplément, plusieurs barres d’outils peuvent être affichées ou masquées au
cours de la création d’une présentation.

Conseil
Vous pouvez fermer le volet Diapo et le volet latéral en cliquant sur les X dans les
coins supérieurs droits de chaque panneau ou en allant à Affichage > Volet diapo ou
Affichage > Volet latéral dans la barre de Menu pour décocher le panneau. Pour rou-
vrir un panneau, cliquez de nouveau sur ces éléments de menu.
Vous pouvez aussi maximiser l’Espace de travail en cliquant sur le bouton de mas-
quage des panneaux au milieu des lignes de séparation (voir Figure 1). Les panneaux
sont masqués mais pas fermés. Pour les faire réapparaître, cliquez une nouvelle fois
sur le bouton.
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Figure 1 : Fenêtre principale d’Impress ; les ovales indiquent les boutons de masquage des 
panneaux. La barre d’onglets est visible sur cette image.

L’espace de travail
L’Espace de travail (qui se trouve normalement au centre de la fenêtre principale) s’ouvre sur la
vue Normale et possède cinq onglets : Normal, Plan, Notes, Prospectus et Trieuse de diapos.
Ces cinq onglets offrent des Vues différentes sur l’Espace de travail. Depuis LibreOffice 5.1, ces
onglets ne sont cependant plus affichés par défaut mais vous pouvez les activer avec le menu
Affichage > Barre d’onglets. L’Espace de travail sous ces boutons change selon la vue choisie.
Les vues de l’espace de travail sont décrites dans « Vues de l’Espace de travail » page 11.

Le volet Diapo
Le volet Diapo contient les miniatures des diapositives de votre présentation dans l’ordre où elles
vont apparaître, à moins que vous ne modifiez celui-ci. Cliquer sur une diapositive dans ce volet la
sélectionne et la place dans l’Espace de travail où vous pouvez lui apporter des modifications.

Plusieurs opérations supplémentaires peuvent être effectuées simultanément sur une ou plusieurs
diapositives dans ce volet.

• Ajouter de nouvelles diapositives à la présentation.
• Masquer une diapositive pour qu’elle ne soit pas affichée au cours de la présentation.
• Supprimer une diapositive de la présentation si elle n’est plus nécessaire.
• Renommer une diapositive.
• Dupliquer (copier et coller) une diapositive.
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• Déplacer une diapositive à un autre emplacement dans l’enchaînement en la tirant et en la
lâchant à la position désirée. Si celle-ci n’est pas visible dans le panneau, la suite des
miniatures glissera vers le haut ou vers le bas pour la faire apparaître.

Il est aussi possible de réaliser les opérations suivantes, bien qu’il existe des méthodes plus effi-
caces que l’utilisation du volet Diapo :

• Changer la transition entre la diapositive sélectionnée et la suivante ou entre chaque diapo-
sitive d’un groupe.

• Modifier l’ébauche de la diapositive.
• Modifier simultanément la mise en page d’un groupe de diapositives.

Le volet latéral
Le volet latéral possède sept sections. Pour déployer la section que vous désirez utiliser, cliquez

sur son icône ou sur le petit triangle en haut des icônes  et faites votre choix dans la liste dérou-
lante. Une seule section peut être ouverte à la fois.

Propriétés 

Affiche les mises en page incluses dans Impress. Vous pouvez choisir celle que vous voulez
et  l’utiliser  telle  qu’elle  ou la  modifier  pour  qu’elle  corresponde à vos exigences.  Il  n’est
cependant pas possible d’enregistrer des mises en page personnalisées.

Pages maîtresses 

Vous pouvez définir ici le style de page (diapositive) de votre présentation. Impress propose
plusieurs modèles de Pages maîtresses. L’une – par défaut – est vide et les autres ont un
arrière-plan et des styles de texte.

Conseil
Allez à Format > Styles > Styles et formatage dans la barre de Menu ou appuyez sur
la touche F11 pour ouvrir la boîte de dialogue Styles et formatage où vous pourrez
modifier les styles utilisés dans les pages maîtresses selon votre convenance. Cela est
possible à tout moment.

Animation personnalisée 

Une grande variété d’animations peuvent être utilisées pour mettre en relief ou attirer l’atten-
tion sur différents éléments d’une diapositive. La section Animation personnalisée offre un
moyen simple pour ajouter, modifier ou supprimer des animations.

Transition 

Propose un grand nombre de transitions entre diapositives. Par défaut, Aucun(e) est sélec-
tionnée ; dans ce cas, la diapositive suivante se contente de remplacer l’actuelle. De nom-
breuses transitions sont cependant disponibles. Vous pouvez aussi préciser la vitesse de
transition (lente, moyenne, rapide), choisir entre une transition automatique ou manuelle et la
durée d’affichage de la diapositive sélectionnée (uniquement pour les transitions automa-
tiques).

La fenêtre principale d’Impress | 9



Styles et formatage 

Vous pouvez éditer et appliquer ici des styles d’images et en créer de nouveau mais vous ne
pouvez que modifier les styles de présentation existants. Quand vous modifier un style, les
changements sont automatiquement appliqués à tous les éléments de votre présentation mis
en forme avec ce style. Si vous voulez être certain que les styles d’une diapositive donnée
ne sont pas mis à jour, créez une nouvelle page maîtresse pour celle-ci.

Gallery 

Ouvre la galerie d’Impress à partir de laquelle vous pouvez insérer un objet dans votre pré-
sentation, soit comme copie, soit comme lien. Une copie d’un objet est indépendante de l’ob-
jet  d’origine.  Les  modifications  de  celui-ci  n’ont  aucun  effet  sur  la  copie.  Un  lien  reste
dépendant de l’objet d’origine. Les modifications de celui-ci se reflètent aussi sur le lien.

Navigateur 

Ouvre le navigateur d’Impress où vous pouvez rapidement atteindre une autre diapositive ou
sélectionner un objet dans une diapositive. Il est recommandé de donner aux diapositives et
aux objets de votre présentation des noms significatifs pour pouvoir facilement les identifier
dans le navigateur.

Barres d’outils
De nombreuses barres d’outils peuvent être utilisées au cours de la création de diapositives. Vous
pouvez les afficher ou les masquer en allant à Affichage > Barres d’outils dans la barre de Menu
et en les cochant dans le sous-menu déroulant.

Vous pouvez aussi choisir les icônes que vous souhaitez voir apparaître dans chaque barre d’ou-
tils. Pour plus d’information, reportez-vous au Chapitre 1, Introduction à LibreOffice.

Beaucoup de barres d’outils d’Impress sont semblables à celles de Draw. Reportez-vous au Guide
Draw pour les détails sur les fonctions disponibles et la manière de les utiliser.

La barre d’état
La barre d’État (Figure 2), située en bas de la fenêtre d’Impress, renferme des informations qui
peuvent vous être utiles quand vous travaillez sur une présentation. Pour plus de détails sur le
contenu et l’utilisation de ces champs, voir le Chapitre 1, Introduction à LibreOffice dans ce guide
et le Guide Impress, Chapitre 1, Introduction à Impress.

Figure 2 : La barre d’état

Remarque
Les tailles sont exprimées dans l’unité de mesure courante (à ne pas confondre avec
les unités de la règle). Cette unité de mesure est définie dans  Outils > Options >
LibreOffice Impress > Général.

De gauche à droite, on trouve :
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• La boîte d’information – elle change selon la sélection. Par exemple :

Exemple de sélection Exemples d’informations affichées

Zone de texte Édition texte : Paragraphe x, Ligne x, Colonne x

Graphique, feuilles de calcul Objet incorporé (OLE) sélectionné(e)s

Images Bitmap avec transparence sélectionné

• Position du curseur – la position du curseur ou du coin en haut à gauche de la sélection,
mesurée à partir du coin en haut à gauche de la diapositive, suivie par la largeur et la hau-
teur de la sélection ou de la zone de texte où le curseur est situé.

• Modifications non sauvegardées – un indicateur signale que le fichier doit être sauve-
gardé. Un double clic sur celui-ci ouvre la boîte de dialogue d’enregistrement de fichiers.

• Signature numérique – une icône signale si le document est signé numériquement. Après
l’enregistrement du fichier, un double clic sur cette icône ouvre la boîte de dialogue de
signatures numériques.

• Numéro de la diapo – le numéro de la diapo actuellement affichée dans l’Espace de tra-
vail et le nombre total de diapos dans la présentation.

• Style de page (Masque de diapo) – le style associé à la diapo, au prospectus ou à la
page de notes actuellement dans l’Espace de travail. Un double clic sur le nom du style
ouvre la boîte de dialogue d’Ébauche de diapo.

• Curseur de zoom – ajuste le pourcentage de zoom de l’Espace de travail.
• Pourcentage de zoom –  indique  le  pourcentage  de  zoom de  l’Espace  de  travail.  Un

double clic sur le pourcentage de zoom ouvre la boîte de dialogue Zoom et disposition des
pages.

Vous pouvez masquer la Barre d’état et ses informations en allant à Affichage dans la barre de
Menu et en décochant Barre d’état.

Vues de l’Espace de travail

Chaque vue de l’Espace de travail est conçue pour faciliter la réalisation de certaines tâches. Il
vous sera donc utile de vous familiariser avec celles-ci pour accomplir rapidement ces tâches.

Remarque
Depuis LibreOffice 5.1, la barre d’onglets des vues des espaces de travail est masquée
par défaut. Pour la rendre visible, cliquez sur Affichage > Barre d’onglets.

Remarque
Chaque vue de l’Espace de travail propose un ensemble différent de barres d’outils.
Ceux-ci peuvent être personnalisés en allant à  Affichage > Barres d’outils dans la
barre de Menu puis en cochant ou décochant les barres que vous désirez ajouter ou
supprimer.

Vue normale
La vue normale est la vue principale qui permet de travailler individuellement sur chaque diaposi-
tive. Utilisez-la pour les mettre en forme, les concevoir, ajouter du texte et des images ou des
effets d’animation.

Pour placer une diapositive dans la zone de conception (vue Normale) (Figure 1 page 8), cliquez
sur sa vignette dans le  Volet Diapo ou faites un double clic dans le  Navigateur (voir Chapitre 1,
Introduction à LibreOffice et le Guide Impress pour plus d’informations sur le Navigateur).
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La vue Plan
La vue Plan (Figure 3)  contient  toutes les diapositives de la  présentation dans l’ordre de leur
numérotation. Elle affiche les titres des éléments, les listes à puces ou numérotées de chaque dia-
positive comme un plan. Comme seul le texte contenu dans les boîtes de texte par défaut de
chaque diapositive est affiché, si celles-ci contiennent d’autres boîtes de texte ou des objets de
dessin, les textes de ces objets n’apparaîtront pas. Les noms des diapositives ne sont pas non
plus affichés.

Figure 3 : La vue Plan

Utilisez la vue Plan pour réaliser les opérations suivantes :

• Insérer du texte pour créer ou éditer rapidement le contenu quand la mise en forme et
l’ajout d’objets graphiques sont reportés à la touche finale de la création.

• Effectuer des modifications dans le texte d’une diapositive :

– Ajouter et supprimer le texte d’une diapositive exactement comme dans la vue Nor-
male.

– Déplacer les paragraphes de texte dans la diapositive sélectionnée en utilisant les bou-
tons en forme de flèches vers le haut ou vers le bas (Déplacer vers le haut ou vers le
bas) de la barre d’outils de Formatage du Texte (soulignés sur la Figure 4).

– Modifier le niveau dans le plan de n’importe quel paragraphe de la diapositive en utili-
sant les boutons en forme de flèches vers la gauche ou vers la droite (Hausser ou
Abaisser d’un niveau) de la barre d’outils de Formatage du Texte.

– Déplacer un paragraphe et modifier en même temps son niveau dans le plan grâce une
combinaison de ces quatre flèches.

• Comparer vos diapositives à votre plan (si vous en avez préparé un auparavant). Si vous
remarquez dans votre plan qu’une diapositive supplémentaire est nécessaire, vous pouvez
la créer directement dans la vue Plan ou retourner à la vue Normale pour la créer.

Figure 4 : Flèches de déplacement et de changement de niveau dans la barre d’outils de 
Formatage du texte

La vue Notes
La vue Notes (Figure 5) vous permet d’ajouter des commentaires à votre diapositive. Ces notes
sont destinées à l’orateur et ne sont pas visibles par l’auditoire quand la présentation est effectuée.

 1) Cliquez sur l’onglet Notes dans l’Espace de travail.
 2) Sélectionnez la diapositive à laquelle vous désirez ajouter des notes : cliquez dans le Volet

Diapo ou faites un double clic sur son nom dans le Navigateur.
 3) Dans la zone de texte sous la diapositive, cliquez sur les mots  Cliquez pour ajouter des

notes et commencez la saisie.
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Vous pouvez modifier la taille de la zone de texte réservée aux notes en utilisant les poignées
colorées qui  apparaissent  quand vous cliquez sur le  cadre de la  zone.  Vous pouvez aussi  la
déplacer en mettant le pointeur sur la bordure puis en cliquant et en la tirant. Pour modifier le style

de texte, cliquez sur l’icône Styles et formatage  dans le Volet latéral.

La vue Prospectus
La vue Prospectus vous permet de définir la disposition de vos diapositives sur un prospectus des-
tiné à être imprimé. Cliquez sur l’onglet  Prospectus et la section Mise en page s’ouvre dans le
Volet latéral (Figure 6). Vous pouvez y choisir si vous allez imprimer 1, 2, 3, 4, 6 ou 9 diapositives

par page. Si cette section ne s’ouvre pas, cliquez sur l’icône Propriété  sur le côté du Volet

latéral.

Utilisez aussi cette vue pour personnaliser les informations imprimées sur le prospectus. Reportez-
vous au Guide Impress, Chapitre 10, Impression, Mailing, Exportation et Enregistrement des Dia-
poramas pour plus d’instructions sur l’impression des diapositives, des prospectus et des notes.

Allez à Insertion > Numéro de page ou Insertion > En-tête et pied de page dans la barre de
Menu pour ouvrir la boîte de dialogue En-tête et pied de page. Cliquez sur l’onglet Notes et pros-
pectus (Figure 7) et choisissez les éléments que vous désirez voir apparaître sur chaque page du
prospectus ainsi que leur contenu. Vous trouverez plus de détails sur l’utilisation de cette boîte de
dialogue dans le Guide Impress.
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Figure 6 : Mise en page des Prospectus

Figure 7 : La boîte de dialogue En-tête et pied de page – Page Notes et 
prospectus

Vue Trieuse de diapos
La vue Trieuse de diapos (Figure 8) affiche toutes les miniatures des diapos. Servez-vous de cette
vue pour travailler avec un groupe de diapos ou avec une seule.

Personnaliser la vue Trieuse de diapos
Pour changer le nombre de diapositives par lignes :

 1) Allez à  Affichage > Barres d’outils et  sélectionnez  Trieuse de diapositives et  Mode
Diapo pour afficher (ou masquer) les barres d’outils correspondantes (Figure 9).

 2) Ajuster le nombre de diapositives (jusqu’à 15 au maximum).
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Figure 8 : La vue Trieuse de diapos

Figure 9 : Les barres d’outils Mode Diapo et Trieuse de diapositives

Déplacer une diapositive avec la Trieuse de diapos
Pour déplacer une diapositive dans une présentation avec la Trieuse de diapos

 1) Cliquez sur la diapo pour la sélectionner (Figure 8).
 2) Tirez-la et déposez-la à l’emplacement que vous désirez.

Sélectionner et déplacer des groupes de diapositives
Pour sélectionner un groupe de diapositives, utilisez une des méthodes suivantes :

• Avec la touche Ctrl – cliquez sur la première diapositive et, tout en appuyant sur la touche
Ctrl, sélectionnez les autres diapositives voulues.

• Avec la touche Maj – cliquez sur la première diapositive et, tout en appuyant sur la touche
Maj, cliquez sur la dernière diapositive du groupe. Cela sélectionne toutes les autres dia-
positives entre la première et la dernière choisies.

• Avec la souris – cliquez légèrement d’un côté (à gauche ou à droite) de la première diapo-
sitive à sélectionner. Maintenez le bouton de gauche enfoncé et tirez le curseur jusqu’à ce
que toutes les diapositives que vous voulez sélectionner soient mises en évidence.

Pour déplacer un groupe de diapositives, sélectionnez-les, tirez le groupe et lâchez-le à son nou-
vel emplacement.

Travailler dans la vue Trieuse de diapos
Vous pouvez travailler sur les diapositives dans la vue Trieuse de diapos exactement comme dans
le Volet Diapo. Pour effectuer des modifications, faites un clic droit sur une diapositive et faites un
des choix suivants dans le menu contextuel :

• Nouvelle diapo – ajoute une nouvelle diapositive après celle qui est sélectionnée (voir
« Des nouvelles diapositives » page 20).

• Dupliquer la diapo – crée un double de la diapositive sélectionnée et place celui-ci immé-
diatement après la diapositive sélectionnée. (voir « Dupliquer une diapositive » page 20).

• Supprimer la diapo – efface la diapositive sélectionnée.
• Renommer la diapo – vous permet de donner un nouveau nom à la diapositive sélection-

née.
• Mise en page – vous permet de modifier la mise en page de la diapositive sélectionnée.
• Transition – vous permet de modifier la transition de la diapositive sélectionnée.
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– Pour une seule diapositive, sélectionnez-la puis ajoutez la transition désirée.
– Pour plusieurs diapositives, sélectionnez un groupe de diapositives puis ajoutez la tran-

sition désirée.

• Masquer la diapo – les diapositives masquées n’apparaissent pas dans le diaporama.
• Couper – supprime la diapositive sélectionnée et l’enregistre dans le presse-papier.
• Copier – copie la diapositive sélectionnée dans le presse-papier sans la supprimer.
• Coller – insère une diapositive contenue dans le presse-papier après la diapositive sélec-

tionnée.

Créer une nouvelle présentation avec l’Assistant de 
Présentation

Cette partie décrit la façon de créer une nouvelle présentation en utilisant l’Assistant de Présenta-
tion.

Conseil
La première chose à faire est de définir le but de la présentation et d’en faire le plan.
Bien que vous puissiez faire des modifications en cours de route, vous épargnerez
beaucoup de temps si vous avez une idée de départ sur la nature de l’auditoire, la
structure, le contenu et la manière dont la présentation sera effectuée.

Quand vous démarrez Impress, l’Assistant de Présentation peut apparaître (Figure 10).

Figure 10 : Choix du type de présentation

 1) À l’étape 1, sous  Type, choisissez une option. Celles-ci sont présentées dans le  Guide
Impress.

– Présentation vierge crée une présentation vide.
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– À partir d’un modèle utilise une ébauche déjà créée comme base d’une nouvelle pré-
sentation. L’Assistant change pour afficher une liste de modèles disponibles où vous
pouvez choisir celui que vous voulez.

– Ouvrir une présentation existante permet de continuer à travailler sur une présentation
créée précédemment. L’Assistant change pour afficher une liste de présentations exis-
tantes où vous pouvez choisir celle que vous voulez.

 2) Cliquez sur  Suivant. La  Figure 11 montre l’Assistant de Présentation à l’étape 2 tel qu’il
apparaît si vous avez précédemment choisi une Présentation vierge. Si vous avez choisi À
partir d’un modèle, un exemple de diapositive est affiché dans la zone d’Aperçu.

Figure 11 : Choix d’une ébauche de diapositive

 3) Choisissez une ébauche sous  Sélectionner une ébauche de diapo. La liste déroulante
vous offre deux choix : Arrière-plans de présentation ou Présentation. Chacun présente une
liste de choix d’ébauches de diapositive. Si vous désirez en utiliser une autre que <Origi-
nal>, cliquez pour la sélectionner.

– Les types d’Arrière-plans de présentation sont visibles sur la Figure 11. Quand vous en
choisissez un, un aperçu de l’ébauche de la diapositive s’affiche dans la zone d’Aperçu.

– <Original> propose une ébauche de diapositive vide.

 4) Choisissez le type d’utilisation de la présentation sous Sélectionner un média de sortie.
La majorité des présentations sont destinées à un écran d’ordinateur, aussi est-il recom-
mandé de choisir Écran. Vous pouvez changer le format de la page à tout instant.

Remarque
Le format d’une page pour l’écran est  par défaut  4/3 (28 cm × 21 cm).  Celui-ci  ne
convient pas aux écrans larges actuels. Utilisez plutôt l’option Plein écran. Vous pou-
vez aussi modifier la taille et les proportions de la diapositive à tout moment en passant
en vue Normale et en allant à Diapo > Propriétés de la page/diapo.
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 5) Cliquez sur Suivant et l’étape 3 de l’Assistant de Présentation apparaît (Figure 12).

Figure 12 : Choix d’un effet de transition

– Choisissez l’effet de transition désiré dans la liste déroulante Effet.
– Choisissez la vitesse de transition entre les différentes diapositives de la présentation

dans la liste déroulante Vitesse. Moyenne est un bon choix pour le moment.
– Sélectionnez le type de présentation. Dans la plupart des cas, choisissez Par défaut :

vous pourrez modifier ce choix plus tard. Pour plus de détails sur le choix  Automa-
tique, voyez le Guide Impress.

Remarque
Si vous n’avez pas choisi de modèle à l’étape 1 de l’Assistant de Présentation, les
étapes 4 et 5 n’apparaîtront pas après l’étape 3. Cliquez sur  Créer pour créer votre
nouvelle présentation.

 6) Cliquez sur Suivant. Quand l’étape 4 de l’Assistant de Présentation apparaît (Figure 13),
vous pouvez saisir des informations sur votre société et la présentation que vous êtes en
train de créer.

 7) Cliquez sur Suivant. À l’étape 5, l’Assistant de Présentation offre un aperçu de l’aspect de
votre présentation (Figure 14). Si celle-ci n’apparaît pas, cochez la case Aperçu.

 8) Si vous voulez créer un sommaire de votre présentation, coches la case Créer un som-
maire.

 9) Cliquez sur Créer pour créer votre nouvelle présentation.
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Figure 13 : Saisie des informations sur la présentation

Figure 14 : Aperçu de la présentation

Conseil
Vous pouvez accepter les valeurs par défaut pour les Effets et la Vitesse à moins que
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vous  n’ayez  des  talents  particuliers  dans  la  création  de  présentations.  Ces  deux
valeurs peuvent être modifiées plus tard pendant le travail sur les transitions entre dia-
positives et les animations. Cela est exposé plus en détails dans le  Guide Impress,
Chapitre 9, Diaporamas.

Formater une présentation

Une nouvelle présentation ne contient qu’une seule diapositive vide. Dans cette partie, nous allons
commencer à en ajouter de nouvelles et à les préparer à recevoir leur contenu.

Insérer des diapositives

Des nouvelles diapositives
Une nouvelle diapositive peut être insérée dans une présentation de la façon suivante :

• Allez à Diapo > Nouvelle page/diapo dans la barre de Menu.
• Faites un clic droit sur la miniature de la diapositive dans le Volet Diapo ou la vue Trieuse

de diapos et choisissez Nouvelle diapo dans le menu contextuel.
• Faites un clic droit dans un endroit vide de l’Espace de travail et choisissez Diapo > Nou-

velle diapo dans le menu contextuel.

• Cliquez sur l’icône Nouvelle page/diapo  dans la barre d’outils Présentation. Vous
pouvez même choisir la disposition de la nouvelle diapo si vous cliquez sur la petite flèche
à côté de l’icône. Si la barre d’outils  Présentation n’est pas visible, allez à  Affichage >
Barres d’outils dans la barre de Menu et choisissez Présentation dans la liste.

Une nouvelle diapositive est insérée dans la présentation après celle qui est sélectionnée.

Dupliquer une diapositive
Plutôt que débuter avec une nouvelle diapositive, vous préférerez parfois dupliquer une diapositive
contenue dans votre présentation. Pour cela, sélectionnez la diapositive que vous désirez dupli-
quer dans le Volet diapo puis

• Allez à Diapo > Dupliquer la page/diapo dans la barre de Menu.
• Faites un clic droit sur la miniature de la diapositive dans le Volet Diapo ou la vue Trieuse

de diapos et choisissez Dupliquer la diapo dans le menu contextuel.

• Cliquez sur l’icône Dupliquer la page/diapo  dans la barre d’outils Présentation. Si la
barre d’outils Présentation n’est pas visible, allez à  Affichage > Barres d’outils dans la
barre de Menu et choisissez Présentation dans la liste.

Une diapositive identique est insérée dans la présentation après celle qui est sélectionnée.

Choisir la mise en page d’une diapositive
Quand on crée une présentation, la première diapositive porte normalement le titre. Vous pouvez
utiliser pour celle-ci une mise en page vide ou avec un titre.

Cliquez sur l’icône Propriétés  sur le côté du Volet latéral pour ouvrir le panneau Mises en

page et afficher celles qui sont disponibles (Figure 15). Elle offre une gamme de possibilité qui
s’étend d’une diapositive vide à une diapositive possédant un titre et six zones de contenu.

Pour créer un titre, si une des mises en page en comportant un a été choisie, cliquez sur Cliquez
pour ajouter un titre puis saisissez le texte. Pour ajouter du texte, selon la mise en page sélection-
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née, cliquez sur Cliquez pour ajouter un texte. Pour ajuster la mise en forme du titre, sous-titre ou
contenu, modifiez le style de présentation : voyez le Guide Impress, Chapitre 2, Utilisez les diapo-
sitives maîtresses, les styles et les modèles pour plus d’information.

Figure 15 : Les mises en page disponibles

Remarque
Les éléments textuels et graphiques peuvent être réajustés à tout moment pendant la
préparation de la présentation, mais modifier la mise en page d’une diapositive qui
possède déjà un contenu peut avoir des répercussions sur le format de celui-ci. Il est
donc recommandé de porter une attention particulière à la mise en page que vous
choisissez pour éviter toute perte de contenu.

Conseil
Pour voir les noms des mises en page proposées, utilisez la fonction Infobulle : placez
le curseur sur une icône de la section Mise en page (ou sur n’importe quelle icône
d’une barre d’outils) et son nom s’affiche dans un petit rectangle.
Dans Outils > Options > LibreOffice > Général > Aide, cochez l’option Infoballons
pour obtenir des informations plus détaillées, mais les noms eux-mêmes ne seront plus
affichés.

Pour choisir ou modifier la mise en page d’une diapositive, sélectionnez-la dans le  Volet Diapo
pour qu’elle apparaisse dans l’Espace de travail puis sélectionnez la mise en page désirée dans la
section Mise en page du Volet latéral. Plusieurs mises en page contiennent un ou plusieurs cadres
de contenu. Chacun de ceux-ci peut être configuré pour contenir du texte, des films, des images,
des graphiques ou des tableaux.

Vous pouvez choisir le type de contenu en cliquant sur l’icône correspondante qui est affichée au
centre de la zone de contenu comme le montre la Figure 16. Si vous avez l’intention d’utiliser la
zone pour du texte, cliquez sur Cliquer pour ajouter du texte.
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Figure 16 : Choix du type de contenu

Modifier les éléments d’une diapositive
Une diapositive contient des éléments qui étaient inclus dans la diapositive maîtresse ainsi que
ceux qui étaient compris dans la mise en page sélectionnée. Il est cependant peu probable que
ceux-ci conviennent à toutes les exigences de vos présentations. Vous désirerez peut-être suppri-
mer des éléments dont vous n’avez pas besoin ou insérer des objets tels que des textes ou des
images.

Bien qu’Impress ne dispose pas de fonction pour créer de nouvelles mises en page, il vous permet
de redéfinir la taille et la position des éléments. Il est aussi possible d’ajouter des éléments sans
être limité par la taille et l’emplacement des cadres d’objets.

Pour modifier la taille d’un cadre de contenu, cliquez sur la bordure externe pour faire apparaître
les poignées qui permettront ce réglage. Pour la déplacer, placer le pointeur de la souris sur la bor-
dure. Quand le pointeur change de forme, vous pouvez cliquer et tirer la boîte à sa nouvelle posi-
tion.

Pour supprimer un élément non désiré :

 1) Cliquez sur l’élément pour le sélectionner ce qui fait apparaître les poignées de modifica-
tion de taille.

 2) Appuyez sur la touche Suppr. pour l’effacer.

Remarque
Les modifications de n’importe quelle mise en page comprise dans Impress ne peut se
faire qu’en utilisant  Affichage > Normal qui est la vue par défaut. Toute tentative de
modification d’une diapositive maîtresse, bien que possible, peut provoquer des résul-
tats imprévisibles et demande un soin particulier ainsi qu’un certain nombre d’essais et
erreurs.
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Ajouter du texte
Pour ajouter du texte à une diapositive qui contient un cadre de texte, cliquez sur  Cliquer pour
ajouter un texte dans ce cadre puis tapez votre texte. Les styles de plan sont automatiquement
ajoutés au texte que vous saisissez. Vous pouvez modifier le niveau de titre de chaque paragraphe
ainsi que sa position dans le texte en utilisant les boutons en formes de flèches de la barre d’outils
Formatage du texte (voir la Figure 4 et « La vue Plan » page 12) ou la touche de tabulation après
avoir placé le curseur au début du paragraphe. Pour plus d’information sur le texte, voir « Ajouter
du texte et le mettre en forme » page24.

Ajouter des objets 
Pour ajouter des objets à une diapositive, par exemple une image, un clip-art, un dessin, une pho-
tographie ou une feuille  de calcul,  cliquez sur  Insertion puis choisissez dans le  menu qui  se
déroule le type d’objet que vous voulez insérer. Pour plus d’informations, voyez « Ajouter des
images, tableaux, diagrammes et vidéos » page 30.

Modifier l’apparence de toutes les diapositives
Pour changer l’arrière-plan et les autres caractéristiques de toutes les diapositives de la présenta-
tion, vous devez modifier la page maîtresse ou en choisir une autre comme il est expliqué dans
« Travailler avec les pages maîtresses et les styles » page 33.

Une page maîtresse est une diapositive qui possède un ensemble de caractéristiques spécifiques
et qui se comporte comme un modèle pour servir de point de départ à la création d’autres diaposi-
tives. Ces caractéristiques comprennent l’arrière-plan, des objets en arrière-plan, le formatage de
tout le texte et toutes les images d’arrière-plan.

Remarque
On parle en anglais de Master slide, master page, ou encore slide master, LibreOffice
dans sa version française utilise les termes  page maîtresse et  masque des diapos.
Tous ces termes se réfèrent à une diapositive que l’on utilise comme modèle pour en
créer d’autres. Ce chapitre utilise le terme page maîtresse, masque de diapo ou style
de diapo suivant le contexte.

Impress possède une gamme de pages maîtresses qui se trouvent dans la section correspondante
du Volet latéral. Vous pouvez aussi en créer et en enregistrer de nouvelles ou en ajouter provenant
d’autres sources. Voyez le Guide Impress, Chapitre 2, Utiliser les pages maîtresses, les styles et
les modèles pour plus d’informations sur la création et la modification des pages maîtresses.

Si vous n’avez besoin que de modifier l’arrière-plan, vous pouvez utiliser un raccourci :

 1) Choisissez  Diapo > Propriétés de la page/diapo et  allez à l’onglet  Arrière-plan de la
boîte de dialogue Mise en page qui s’ouvre alors.

 2) Choisissez le type d’arrière-plan parmi couleur, dégradé, hachure et bitmap.
 3) Cliquez sur OK pour l’appliquer.
 4) Une boîte de dialogue s’ouvre pour vous demander si cet arrière-plan doit s’appliquer à

toutes les diapositives. Cliquez sur Oui si vous désirez modifier toutes les diapositives et
Impress adaptera automatiquement la page maîtresse pour vous.

Remarque
Insérer et formater correctement un arrière-plan va au-delà de la portée de ce chapitre,
mais vous pouvez trouver toutes les informations nécessaires dans le  Guide Draw,
Chapitre 4, Modifier les attributs d’un objet ou dans le Guide Impress, Chapitre 6, For-
mater les objets graphiques.
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Modifier le diaporama
Par défaut, le diaporama affiche toutes les diapositives dans l’ordre où elles apparaissent dans la
Trieuse de diapos, sans aucune transition entre elles. Vous devez intervenir avec le clavier ou la
souris pour passer d’une diapositive à la suivante.

Vous pouvez utiliser  Diaporama dans la barre de Menu pour changer l’ordre des diapos, choisir
celles qui apparaîtront, automatiser le passage d’une diapo à la suivante et d’autres paramétrages.
Pour modifier les transitions entre diapositives, les animer, ajouter du son à la présentation et faire
d’autres améliorations, vous devez utiliser des fonctions du Volet latéral. Voyez le Guide Impress
pour plus de détails sur la manière d’utiliser toutes ces fonctions.

Ajouter du texte et le mettre en forme

Beaucoup de vos diapositives vont probablement contenir du texte. Cette partie offre quelques
lignes directrices sur la manière d’ajouter du texte et de modifier son apparence. Le texte qui appa-
raît dans les diapositives est contenu dans des cadres de texte.  Pour plus d’informations sur ce
sujet, voir Chapitre 3 Ajouter et formater un texte du Guide Impress.

Vous pouvez ajouter deux types de cadres de texte à une diapositive :

• choisissez une mise en page prédéfinie dans la section Mise en page du Volet latéral sans
sélectionner un type de contenu particulier mais saisissez votre texte. Ces cadres de texte
s’appellent des cadres à Mise en forme automatique.

• Créez un cadre de texte en utilisant le bouton  Zone de texte  de la barre d’outils

Standard (Figure 17) ou de la barre d’outil Texte (Figure 18) ou avec le raccourci F2.

Figure 17 : La barre d’outils Standard

Figure 18 : La barre d’outils Texte

Utiliser les cadres de texte à Mise en page automatique
 1) Vérifiez que vous vous trouvez dans la vue Normale.
 2) Cliquez dans le cadre de texte à l’endroit où s’affiche Cliquez pour ajouter un texte.
 3) Saisissez ou collez votre texte dans le cadre.

Utiliser les cadres de texte
 1) Vérifiez que vous vous trouvez dans la vue Normale.

 2) Cliquez sur le bouton Zone de texte  de la barre d’outils Standard ou de la barre d’ou-

til Texte ou appuyez sur la touche F2. Si les barres d’outils Standard ou Texte ne sont pas
visibles, allez à Affichage > Barres d’outils dans la barre de Menu et cochez Standard ou
Texte.

 3) Cliquez et tirez pour tracer un cadre pour le texte sur la diapositive. Ne vous préoccupez
pas de sa taille verticale et de sa position : le cadre s’ajustera au fur à mesure que vous
ajouterez du texte.
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 4) Relâchez le bouton de la souris quand vous avez fini. Le curseur apparaît dans le cadre de
texte, vous êtes maintenant en mode édition (bordures colorées bleu-ciel, voir Figure 19).

Figure 19 : Créer et modifier un cadre de texte

 5) Saisissez ou collez votre texte dans le cadre.
 6) Cliquez en dehors du cadre pour sortir du mode édition.

Vous pouvez redimensionner, déplacer, supprimer un cadre-texte. Pour plus d’informations, voir
Chapitre 3 Ajouter et formater un texte dans le Guide Impress.

Texte vertical
En plus des cadres de texte normaux où le texte est aligné horizontalement, il est possible d’insé-
rer des cadres de texte où celui-ci est aligné verticalement. Ces cadres de texte vertical ne sont
disponibles que si les langues asiatiques ont été activées dans Outils > Options > Paramètres

linguistiques > Langues. Cliquez sur l’icône Texte vertical  dans la barre d’outils Standard

ou la barre d’outils Texte pour créer un cadre de texte vertical.

Modification rapide de la taille de la police
Impress propose deux icônes (soulignées sur la  Figure 20) dans la barre d’outils  Formatage du
texte pour augmenter ou diminuer la taille de la police du texte sélectionné. L’échelle des valeurs
disponibles dépend des tailles standard disponibles pour la police en cours.

Figure 20 : Modification rapide de la taille de la police 
dans la barre d’outils Formatage du texte

Remarque
Les cadres de texte à Mise en forme automatique peuvent redimensionner automati-
quement les polices pour que le cadre contienne tout le texte que vous saisissez. Si
vous insérez un texte long, la taille de la police peut diminuer pour qu’il tienne dans le
cadre, sinon la police conserve sa taille par défaut.

Coller du texte
Vous pouvez insérer du texte dans un cadre de texte en le copiant depuis un autre document et en
le collant dans Impress. La mise en forme du texte ainsi collé ne correspondra cependant pas à
celle des autres textes de la diapositive ni à celle des autres diapositives de la présentation. Cela
peut parfois correspondre à ce que vous désirez, mais, dans la plupart des cas, vous voudrez vous
assurer que le style de la présentation est cohérent et ne se transforme pas en une mosaïque de
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styles différents de paragraphes, de polices, de puces. Il existe plusieurs façons d’assurer l’homo-
généité de votre présentation.

Coller du texte non formaté
C’est généralement une bonne habitude de coller un texte sans mise en forme puis de lui appli-
quer le formatage. Pour coller un texte sans mise en forme :

• Appuyez sur les touches Ctrl+Maj+V et choisissez Texte non formaté dans la boîte de
dialogue Collage spécial qui s’ouvre.

• Cliquez sur le petit triangle à côté de l’icône Coller de la barre d’outils Standard et choisis-
sez Texte non formaté dans le menu déroulant.

Le texte non formaté sera mis en forme avec le style du niveau de plan ou du paragraphe à la
position du curseur dans un cadre de Mise en forme automatique ou avec le style par défaut dans
un cadre de texte ordinaire.

Formater le texte collé
Pour mettre en forme le texte que vous avez collé, vous pouvez utiliser les outils disponibles dans
la barre d’outils Formatage du texte (Figure 21) ou dans les sections Caractère et Paragraphe du
panneau Propriétés du Volet latéral (Figure 22). Si ces sections n’apparaissent pas automatique-

ment quand vous sélectionnez du texte, cliquez sur l’icône Propriétés  à droite du Volet laté-

ral.

Figure 21 : La barre d’outils Formatage du texte

Si vous collez du texte dans un cadre à mise en forme automatique, vous devez appliquer le
style approprié à votre texte pour lui donner la même apparence que le reste de la présentation.

 1) Collez le texte à l’emplacement désiré.
 2) Sélectionnez le texte que vous venez de coller.
 3) Sélectionnez Format > Formatage par défaut dans la barre des menus.
 4) Utilisez les quatre flèches dans la barre d’outils Formatage du texte (voir Figure 4 page 12)

pour  déplacer  le  texte  à  la  position  appropriée  et  lui  donner  le  style  automatique  qui
convient.

– La flèche gauche élève une entrée de liste d’un rang (par exemple de Titre 3 à Titre 2).
Vous pouvez aussi obtenir  le même résultat  en plaçant  le curseur en tête de para-
graphe et en appuyant sur Maj+Tab.

– La flèche droite descend une entrée de liste d’un rang. Appuyez sur la touche de tabu-
lation pour obtenir le même résultat après avoir placé le curseur en début de para-
graphe.

– La flèche vers le haut fait monter une entrée dans la liste.
– La flèche vers le bas fait descendre une entrée dans la liste.

 5) Appliquez au texte la mise en forme désirée pour modifier la police, les tabulations, etc.

Si vous collez le texte dans un cadre de texte, vous pouvez aussi utiliser les styles pour le formater
rapidement. Un seul style d’image peut être appliqué dans le cadre :

 1) Collez le texte à l’emplacement désiré.
 2) Sélectionnez le texte que vous venez de coller.
 3) Sélectionnez le style d’image souhaité.
 4) Appliquez le formatage manuel si nécessaire.
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Figure 22 : Les sections Caractère et Paragraphe du Volet latéral (onglet Propriétés)

Créer des listes à puces ou numérotées
La procédure pour créer une liste à puces ou numérotée est sensiblement différente en fonction du
type de cadre utilisé, cependant, l’outil pour gérer les listes et les personnaliser est le même.

Dans les cadres créés automatiquement par application d’une mise en page les styles hiérar-
chiques disponibles sont par défaut des listes à puces, alors que dans les cadres de texte nor-
maux une étape supplémentaire est nécessaire pour créer une liste à puces.

Cas des cadres à mise en page automatique
Tous les cadres de texte créés dans les zones avec une mise en forme automatique sont déjà for-
matés comme des listes à puces. La marche à suivre est alors la suivante :

 1) À partir du panneau Mises en page du volet Tâches, choisissez un modèle de diapo qui
vous convient.

 2) Cliquez dans le cadre où s’affiche : Cliquez pour ajouter un texte.
 3) Saisissez votre texte, appuyez sur Entrée pour ajouter une nouvelle entrée dans la liste.

Par défaut, il s’agit d’une liste à puces. La méthode pour transformer une liste à puces en liste
numérotée est expliquée à la section « Changer l’apparence d’une liste » page 29.
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Conseil
Appuyez sur Maj + Entrée pour ajouter une nouvelle ligne sans puce ni numéro. La
nouvelle ligne sera indentée comme la précédente. Pour retirer toutes les puces, sélec-

tionnez la liste et cliquez sur le bouton (Dés)activer les puces  de la barre d’ou-

tils  Formatage  du  texte.  Si  la  barre  d’outils  Formatage  du  texte  n’est  pas  visible,
activez-la via le menu Affichage > Barre d’outils > Formatage du texte (Figure 21
page 26).

Cas des autres cadres de texte
Pour créer une liste dans un cadre-texte normal, suivez les étapes suivantes :

1) Placez le curseur dans le cadre de texte.

2) Cliquez le bouton (Dés)activer les puces  sur la barre d’outils Formatage du texte.

3) Saisissez le texte et appuyez sur Entrée pour commencer une nouvelle ligne à puces.

La liste par défaut est une liste à puces ; la méthode pour changer l’apparence de la liste est
décrite à la section « Changer l’apparence d’une liste » page 29.

Ajouter un nouveau niveau hiérarchique
Si nécessaire, appuyez sur Entrée pour ajouter une ligne.

• Pour diminuer une entrée d’un niveau (et la déplacer vers la droite), vous pouvez :

– appuyer sur la touche tabulation,
– cliquer sur le bouton Abaisser d’un niveau (flèche vers la droite) dans la barre d’outils

Formatage du texte (Figure 4 page 12),
– appuyer sur les touches Alt+Maj+Flèche droite.

L’entrée se déplace vers la droite pour prendre l’indentation du niveau de titre suivant.
• Pour diminuer une entrée d’un niveau (et la déplacer vers la droite), vous pouvez :

– appuyer sur les touches Maj+Tab,
– cliquer sur le bouton Hausser d’un niveau (flèche vers la gauche) dans la barre d’ou-

tils Formatage du texte (Figure 4 page 12),
– appuyer sur les touches Alt+Maj+Flèche gauche.

L’entrée se déplace vers la gauche pour prendre l’indentation du niveau de titre précédent.
• Pour créer une nouvelle entrée au même niveau que la précédente, appuyez sur Entrée.

Dans les cadres de texte à mise en forme automatique, abaisser ou hausser d’un niveau un élé-
ment de la liste correspond à appliquer un style hiérarchique différent ; donc le second niveau d’in-
dentation  correspond  au  style  Plan  2,  le  troisième  au  style  Plan  3  et  ainsi  de  suite.  En
conséquence, une modification de niveau hiérarchique produit un changement de style (taille de
police, puce différente…) paramétrable dans le masque de diapositive.

Dans les autres cadres de texte, un nouveau niveau de plan ne peut être créé qu’avec la touche
de tabulation pour abaisser l’entrée d’un niveau ou avec les touches  Maj+Tab pour la hausser
d’un niveau.

Remarque
N’essayez pas de changer de niveau en sélectionnant le texte puis en cliquant sur le
style comme vous auriez appliqué un style avec Writer. Le fonctionnement intrinsèque
des styles de présentation empêche de procéder de la sorte.
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Changer l’apparence d’une liste
Vous pouvez complètement personnaliser l’apparence d’une liste, en changer les puces, la numé-
rotation pour la liste entière ou une simple entrée. Toutes les modifications sont accessibles via la
boîte de dialogue Puce et numérotation, à laquelle vous accédez via le menu Format > Puces et

numérotation ou en cliquant sur l’icône (Dés)Activer les puces  et (Dés)Activer la numé-

rotation  de la barre d’outils Formatage du texte.

Figure 23 : La boîte de dialogue Puces et numérotation

Pour la liste entière :

 1) Sélectionnez la liste dans sa totalité ou cliquez sur la bordure grise du cadre (de manière à
ce que les poignées colorées apparaissent).

 2) Sélectionnez Format > Puces et numérotation ou cliquez sur l’icône Puces et numérota-

tion  de la barre d’outils Formatage du texte.

 3) La boîte de dialogue Puces et numérotation (Figure 23) contient cinq onglets : Puces, Type
de numérotation, Image, Position, Personnaliser.

– Si vous avez besoin d’une liste à puces, choisissez son apparence parmi les exemples
disponibles dans l’onglet Puces.

– Si vous avez besoin d’un effet graphique, choisissez parmi ceux disponibles dans l’on-
glet Images.
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– Si vous avez besoin d’une liste numérotée, choisissez parmi les propositions de l’onglet
Numérotation.

– Utilisez la page Position pour définir le retrait, la largeur et l’alignement de la numérota-
tion utilisé dans votre liste.

– Utilisez la page Personnaliser définir la numérotation, la couleur, la taille relative et le
caractère utilisé dans votre liste.

 4) Pour obtenir  une puce différente dans la liste, cliquez n’importe-où sur cette ligne pour
positionner le curseur dessus, puis suivez les étapes 2 et 3 des instructions précédentes.

Si la liste se trouve dans un cadre avec une mise en forme automatique, alors une alternative pour
modifier la liste entière consiste à modifier le style hiérarchique. L’avantage de cette méthode, c’est
que les modifications sur le style s’appliqueront à toutes les diapositives qui utilisent ce style, per-
mettant de maintenir l’homogénéité de la présentation.

Ajouter des images, tableaux, diagrammes et vidéos

Comme nous l’avons montré sur la Figure 16 en page 22, un cadre d’objet peut abriter non seule-
ment un texte mais aussi une image, un tableau, un diagramme, une séquence vidéo. Nous allons
maintenant vous donner un aperçu rapide des méthodes de manipulation de ces objets. Vous trou-
verez des descriptions plus détaillées dans le Guide Impress.

Ajouter des images
Pour ajouter une image à un cadre d’objet :

 1) Allez sur  Insertion > Image de la barre de menus principale ou à  Insertion > Média >
Scanner > Acquérir.

Une alternative consiste à cliquer sur l’icône d’insertion d’image du cadre  (Figure 16

en page  22) puis sélectionner le fichier dans la  boîte de dialogue  Insérer une image qui
s’ouvre. Pour voir un aperçu de l’image, cochez Aperçu dans la partie inférieure gauche de
la fenêtre.

 2) Déplacez l’image à la position souhaitée.

L’image sera redimensionnée automatiquement pour remplir l’espace du cadre. Suivez les conseils
ci-dessous quand vous redimensionnez une image.

Remarque
Pour redimensionner une image, cliquez dessus avec le bouton de droite. Sélectionnez
Position et taille dans le menu contextuel et assurez-vous que l’option Conserver le
ratio est  activée.  Ensuite  ajustez  la  valeur  du champ  Largeur ou  Hauteur à  votre
besoin (en modifiant une valeur, l’autre est automatiquement modifiée en proportion).
Sans cette précaution, votre image risque de subir des distorsions. Vous pouvez égale-
ment  redimensionner  l’image  par  cliquer-glisser  sur  les  poignées en  maintenant  la
touche Maj enfoncée pour conserver la proportion entre la hauteur et la largeur.

Ajouter des tableaux
 1) Pour ajouter un tableau simple à une diapositive, vous pouvez :

– Aller au menu Insertion > Tableau dans la barre de menus ou cliquer sur le bouton

Tableau  dans la barre d’outils  Standard ou de la barre d’outils  Tableau qui est
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visible si la diapositive contient déjà un tableau et si celui-ci est sélectionné. Choisir le
nombre de lignes et de colonnes souhaitées dans la palette qui s’ouvre alors. 
La barre d’outils Tableau n’est visible qu’après avoir coché Affichage > Barres d’outils
> Tableau dans la barre de menu ou quand un tableau est sélectionné.

– Après avoir inséré une nouvelle diapositive dans votre présentation, cliquer sur l’icône

Insérer un tableau  (Figure 16 en page 22). Choisissez le nombre de lignes et de

colonnes que vous désirez dans la boîte de dialogue Insérer un tableau qui s’ouvre
alors.

 2) Sélectionnez un style de tableau parmi les choix proposés dans la section  Ébauche de
tableau du panneau Propriétés du Volet latéral. Si celle-ci n’apparaît pas automatiquement

après avoir inséré ou sélectionné un tableau, cliquez sur l’icône Propriétés  à côté du
Volet latéral.

Figure 24 : Section Ébauche de tableau dans le Volet latéral

Remarque
Choisir  un des styles dans la  section Ébauche de tableau du volet  latéral  crée un
tableau basé sur ce style. Si vous créez un tableau par une autre méthode, vous pour-
rez toujours lui appliquer le style de votre choix plus tard.

La barre d’outils Tableau offre les mêmes icônes que celles de Writer, à l’exception des fonctions
Tri et Somme. Pour réaliser des calculs et des tris, vous devrez insérer une feuille de calcul depuis
Calc.

Après avoir créé votre tableau, vous pouvez le modifier à votre guise, comme vous le feriez avec
un tableau dans Writer (ajouter ou supprimer des lignes ou des colonnes, ajuster la largeur ou
l’écart, dessiner des bordures, couleurs de fonds, et ainsi de suite). Des informations détaillées
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pour travailler avec les tableaux et leurs propriétés se trouvent au Chapitre 3 Ajouter et formater
du texte du Guide Impress et au Chapitre 9 Travailler avec des tableaux du Guide Writer.

Après avoir défini l’aspect de votre tableau, vous entrerez les données dans les cellules. L’opéra-
tion est similaire à entrer du texte dans un cadre. Cliquez dans une cellule pour insérer les don-
nées et saisissez-les. Pour vous déplacer entre les cellules, utilisez les touches suivantes :

• Les touches de déplacement (les flèches) déplacent le curseur dans la cellule suivante si la
cellule est vide, sinon le curseur se déplace sur le prochain caractère dans la cellule.

• La  touche Tabulation vous déplace dans la cellule suivante quel que soit le contenu des
cellules ; Maj+Tab vous déplace en sens inverse.

Ajouter des diagrammes
Pour insérer un diagramme dans une diapositive vous pouvez :

• soit utiliser le menu Insertion > Diagramme,

• soit cliquer sur l’icône Diagramme  de la barre d’outils principale,

• soit (dans une zone à mise en forme automatique) cliquer sur l’icône Insérer un diagramme

 au centre du cadre (Figure 16 en page 22).

Impress affiche un diagramme par  défaut  dans la  fenêtre  contextuelle  des  diagrammes.  Pour
modifier le type de diagramme, saisir vos propres données et changer la mise en forme, référez-
vous au Guide Impress.

Ajouter des fichiers multimédias
Pour insérer des fichiers multimédias dans une diapositive, vous pouvez :

• utiliser le menu Insertion > Son ou Vidéo.
• après avoir inséré une nouvelle diapo, cliquer sur l’icône Insérer un fichier audio ou vidéo

 au centre du cadre (Figure 16 en page 22).

Un lecteur de média s’ouvre en bas de l’écran pour vous permettre d’avoir un aperçu de celui-ci.
Quand le fichier inséré est un fichier audio, le cadre de contenu affiche l’image d’un haut-parleur.

Ajouter des dessins, feuilles de calculs et autres objets
Les dessins comme des formes, des légendes, des flèches sont souvent utiles en complément au
texte d’une diapositive. Vous manipulerez ces objets de la même façon que les dessins avec Draw.
Pour plus d’informations, voir Chapitre 7 Débuter avec Draw dans le Guide du débutant, ou Cha-
pitre 4, 5 et 6 du Guide Impress.

Les feuilles de calcul imbriquées dans Impress offrent la plupart des fonctionnalités des feuilles de
calcul du logiciel Calc et sont donc capables de réaliser des calculs et analyses de données élabo-
rés. Si vous devez analyser vos données ou effectuer des calculs, ces opérations sont plus aisées
à réaliser dans une feuille de calcul de Calc. Puis vous pourrez afficher le résultat dans une feuille
de calcul imbriquée dans Impress ou mieux encore dans un tableau natif Impress.

Choisissez Insertion > Objet > Objet OLE > Classeur LibreOffice depuis la barre des menus.
Par défaut cela ouvre une feuille de calcul au milieu de la diapositive et les menus et barres d’ou-
tils deviennent ceux du logiciel  Calc. Pour pouvoir saisir vos données, vous aurez probablement
besoin de redimensionner la zone de la feuille de calcul visible. Vous pouvez également insérer
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une feuille de calcul existante et utiliser la zone de sélection pour délimiter les données que vous
souhaitez afficher dans votre diapositive.

Impress vous permet d’insérer une grande variété d’objets comme un document  Writer, des  for-
mules Math, et même une autre présentation. Pour les détails sur l’utilisation de ces objets, repor-
tez-vous au  Chapitre 7 Inclure  des feuilles de calcul,  diagrammes,  et  autres objets du  Guide
Impress.

Travailler avec les pages maîtresses et les styles

Une page maîtresse est une diapositive utilisée comme point de départ pour la création d’autres
diapositives. Équivalente aux styles de page de Writer, elle détermine le formatage de base de
toutes les diapositives basées dessus. Un diaporama peut utiliser plusieurs pages maîtresses.

Remarque
On parle en anglais de Master slide, master page, ou encore slide master, LibreOffice
dans sa version française utilise les termes  page maîtresse et  Masque des diapos.
Tous ces termes se réfèrent à une diapositive que l’on utilise comme modèle pour en
créer d’autres. Ce chapitre utilise le terme page maîtresse, masque de diapo ou style
de diapo suivant le contexte.

Une page maîtresse dispose d’un ensemble défini de caractéristiques, dont un arrière-plan, des
dessins, des objets (logos, lignes décoratives) en arrière-plan, un en-tête, un pied de page, la posi-
tion et la taille des cadres de texte et le formatage du texte.

Styles
Toutes les caractéristiques d’une page maîtresse sont contrôlées par les styles. Les styles d’une
nouvelle diapositive sont hérités de la page maîtresse à partir de laquelle elle a été créée. En
d’autres mots, les styles de la page maîtresse sont disponibles et appliqués dans chaque nouvelle
diapositive qui utilise cette page maîtresse. Modifier un style dans une page maîtresse modifie
toutes les diapositives basées sur cette page maîtresse ; vous pouvez évidemment modifier indivi-
duellement une diapositive sans modifier la page maîtresse, mais vous perdrez alors l’homogé-
néité de votre présentation.

Remarque
Par conséquent il est recommandé d’utiliser la page maîtresse à chaque fois que c’est
possible. Cependant à certaines occasions il est nécessaire d’effectuer des change-
ments manuels dans une diapositive en particulier. Si la même mise en forme doit être
utilisée ultérieurement, il vaut mieux alors créer une nouvelle page maîtresse.

Les pages maîtresses mettent en œuvre deux types de styles : les  styles de présentation et les
styles d’images. Vous pouvez modifier les styles de présentation prédéfinis mais vous ne pouvez
pas en créer. Vous pouvez modifier les styles d’images prédéfinis et en créer de nouveaux.

Les styles de présentation affectent  trois  éléments d’une page maîtresse :  l’arrière-plan,  les
objets d’arrière-plan (tels que les icônes, lignes décoratives, cadre texte), et le texte placé sur la
diapositive. Les styles de texte se répartissent en Notes,  Plan 1 à Plan 9, Titre et Sous-titre. Les
styles Plan s’appliquent aux différents niveaux hiérarchiques du plan.

Les styles d’images affectent de nombreux éléments d’une diapositive. Notez que des styles de
texte existent dans les deux sections styles de présentation et styles d’images.
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Page maîtresse
Impress offre une collection de pages maîtresses qui apparaissent dans le panneau Pages maî-
tresses du volet latéral (Figure 25). Le panneau se divise en trois sections :  Utilisées dans cette
présentation,  Récemment  utilisées,  Disponibles  pour  l’utilisation.  Vous  pouvez  développer  ou
réduire les sections en cliquant sur les symboles + ou – à gauche du nom de la section.

Chaque page maîtresse accessible dans  Disponibles pour l’utilisation est issue d’un modèle du
même nom. Si  vous avez créé vos propres modèles ou ajoutés des modèles depuis  d’autres
sources (par exemple des extensions), les pages maîtresses de ces modèles apparaîtront égale-
ment dans cette liste.

Créer un masque/une page maîtresse
 1) Pour commencer, activez l’édition des masques en sélectionnant Affichage > Masque des

diapos et la barre d’outils Mode masque apparaît. Si ce n’est pas le cas, allez à Affichage
> Barres d’outils et cochez Mode Masque.

Figure 26 : La boîte de dialogue Mode Masque

Vous pouvez aussi appliquer un clic droit sur la vignette du masque dans du volet latéral et
choisir Éditer le masque dans le menu contextuel.

 2) Sur la barre d’outils Mode Masque, cliquez l’icône Nouveau masque .

 3) Un second masque apparaît, dans le volet Diapos. Modifiez ce masque en fonction de vos
besoins.

 4) Pensez à renommer ce masque : clic droit sur la vignette du nouveau masque dans le volet
Diapos et choisissez Renommer le masque dans le menu contextuel.

 5) Quand vous avez terminé, quittez l’édition du masque en cliquant sur le bouton Fermer le
mode Masque (Figure 26).
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Appliquer une page maîtresse
Depuis le volet latéral, affichez le panneau Pages maîtresses (Figure 25). Les nouveaux masques
apparaissent dans les pages maîtresses.

Pour  appliquer une page maîtresse à toutes les diapositives de votre présentation, faites un clic
droit sur celle-ci et choisissez Appliquer à toutes les diapositives dans le menu contextuel.

Pour appliquer une page maîtresse différente à une ou plusieurs diapositives sélectionnées :

 1) Dans le  volet  Diapos ou la vue Trieuse de diapositives, sélectionnez les diapositives que
vous voulez modifier.

 2) Dans le volet latéral, faites un clic droit sur la page maîtresse que vous voulez appliquer
(aux diapositives sélectionnées) puis choisissez  Appliquer aux diapositives sélection-
nées dans le menu contextuel.

Charger des pages maîtresses supplémentaires
Parfois, dans le même diaporama vous aurez besoin d’utiliser différentes pages maîtresses appar-
tenant à plusieurs modèles. Par exemple, vous pourriez avoir besoin d’une page maîtresse com-
plètement  différente  pour  la  première  diapositive  de  votre  présentation,  ou  encore  vous
souhaiteriez ajouter  à votre présentation une diapositive appartenant  à une autre présentation
(basée sur un modèle disponible sur votre disque-dur). La fenêtre Ébauche de Diapo (Figure 27)
rend cela possible. Accédez à cette fenêtre soit par le menu Diapo > Conception de diapo soit
par le menu contextuel qui apparaît quand vous cliquez-droit sur une vignette de diapositive du
volet Diapos.

Figure 27 : La boîte de dialogue Ébauche de diapo

La zone principale de la boîte de dialogue montre les pages maîtresses déjà disponibles. Pour en
ajouter d’autres :
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 1) Cliquez sur le bouton Charger.
 2) Sélectionnez dans la nouvelle boîte de dialogue (Charger un style de diapo Figure 28) le

modèle à partir duquel charger la page maîtresse puis cliquez sur OK.
 3) Cliquez une seconde fois sur OK pour fermer la fenêtre Ébauche de diapo.

Les pages maîtresses du modèle que vous avez sélectionné sont maintenant disponibles dans le
panneau Pages maîtresses du volet Tâches, dans la section Disponibles pour l’utilisation.

Figure 28 : Boîte de dialogue Charger un style de diapo

Remarque
Les pages maîtresses que vous avez chargées seront aussi disponibles la prochaine
fois que vous utiliserez votre présentation. Si vous voulez supprimer les pages maî-
tresses inutilisées,  cliquez sur l’option correspondante dans la  fenêtre  Ébauche de
diapo (Figure 27). Les pages maîtresses qui ne sont pas utilisées dans la présentation
sont alors enlevées de la liste Disponibles pour l’utilisation.

Conseil
Pour limiter la taille du fichier de votre présentation, vous devrez minimiser le nombre
de pages maîtresses utilisées.

Modifier une page maîtresse
Sur une page maîtresse, vous pouvez modifier les points suivants :

• Arrière-plan (couleur, dégradé, hachure, image)
• Objets d’arrière-plan (ajouter un logo ou un dessin décoratif)
• Taille, position et contenu des en-tête et pied de page qui apparaîtront sur chaque diapo.
• Taille et position des cadres par défaut pour les zones de titre et de contenu.

Pour plus d’information sur la modification des pages maîtresses, voyez le  Guide Impress, Cha-
pitre 2, Utilisation des Pages maîtresses, des Styles et des Modèles.

Avant de travailler sur une page maîtresse assurez-vous que la fenêtre  Styles et formatage est
ouverte (touche F11).

Pour sélectionner la page maîtresse à modifier :
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 1) Sélectionnez Affichage > Masque des diapos à partir de la barre des menus. Cela déver-
rouille les propriétés de la page maîtresse afin que vous puissiez les éditer.

 2) Sélectionnez une page maîtresse dans le volet diapo.
 3) Sélectionnez un objet dans la page maîtresse qui se trouve dans l’espace de travail et le

volet latéral  affiche les propriétés de cet objet qui peuvent être modifiées. La  Figure 29
montre un objet texte sélectionné et la section propriété des textes ouverte dans le  volet
latéral.

 4) Effectuez toutes les modifications voulues dans la page maîtresse puis cliquez sur le bou-
ton  Fermer le mode Masque de la barre d’outils  Mode Masque ou allez à  Affichage >
Normal dans la barre de menu pour arrêter l’édition des pages maîtresses.

 5) Enregistrez votre présentation avant de continuer.

Attention
Toute modification faite  sur  une diapositive en mode Masque de Diapos impactera
toutes les diapositives qui utilisent la même page maîtresse. Prenez soin de toujours
fermer le mode Masque de Diapos et de revenir en mode Normal avant de travailler
sur une diapositive quelconque de la présentation. Sélectionner  Affichage > Normal
depuis la barre des menus, ou cliquer sur Fermer le mode Masque de la barre d’outils
Mode Masque.

Figure 29 : Édition d’une page maîtresse

Remarque
Les changements affectés à une diapositive en mode Normal (par exemple, modifier le
style des puces d’une liste, la couleur de la zone de titre…) ne seront pas altérés par
des modifications contradictoires sur la page maîtresse. Cependant vous pouvez annu-
ler les modifications manuelles apportées à un objet pour revenir au style défini par la
page  maîtresse.  Sélectionnez  l’élément  puis  choisissez  Format  >  Formatage  par
défaut dans la barre des menus.
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Ajouter un texte, des pieds de page et des champs à toutes les 
diapositives
Une page maîtresse peut posséder un texte, des pieds de page ou des champs qui apparaîtront
sur toutes les diapositives de votre présentation. Les en-têtes ne sont normalement pas ajoutés
aux diapositives.

Le texte
 1) Choisissez  Affichage > Masques des Diapos depuis la barre des menus pour ouvrir la

vue Page maîtresse (Figure 30).
 2) Sur la barre d’outils Dessin, cliquez le bouton Texte ou bien appuyez sur la touche F2.
 3) Cliquez-glissez dans votre page maîtresse pour dessiner le cadre-texte, saisissez ou collez

votre texte à l’intérieur ou ajoutez des champs comme indiqué ci-dessous.
 4) N’oubliez pas : Affichage > Normal ou cliquer sur le bouton Fermer le mode Masque de

la barre d’outils Mode Masque dès que vous avez terminé.

Les pieds de page
Pour ajouter un pied de page à vos diapositives :

 1) Allez à Affichage > Masques des Diapos depuis la barre des menus pour ouvrir la vue
Page maîtresse (Figure 30).

 2) Allez à  Insertion > Numéro de page ou  Insertion > En-tête et pied de page dans la
barre de menus pour ouvrir la boîte de dialogue En-tête et pied de page (Figure 31).

 3) Sélectionnez le type de date et d’heure, saisissez le texte du pied de page et choisissez
d’afficher le numéro de diapositive dans les options de la boîte de dialogue.

Figure 30 : Exemple de page maîtresse
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 4) Cliquez sur  Appliquer partout pour appliquer vos modifications à toutes les pages maî-
tresses de votre présentation ou sur Appliquer pour les appliquer à celle qui est sélection-
née.

 5) Vous pouvez aussi ajouter une date et une heure, un texte de pied de page et un numéro
de diapositive directement sans leurs cadres respectifs comme on le voit sur la Figure 30.

Figure 31 : La boîte de dialogue En-tête et pied de page dans Impress

Remarque
Normalement, seuls les pieds de page sont utilisés sur une diapositive. Pour créer un
en-tête, vous pouvez utiliser un cadre de texte comme décrit dans « Le texte » page
38.

Les champs
Pour insérer un champ tel que la date ou le numéro de page, à l’intérieur d’un cadre ou en tant
qu’objet séparé, sélectionnez Insertion > Champs puis choisissez le champ requis dans le sous-
menu. Pour éditer ce champ dans votre diapositive, et pour plus d’information, voir  Chapitre 3,
Ajouter et formater le texte du Guide Impress.

Les champs que vous pouvez utiliser dans Impress sont :

• Date (fixe).
• Date (variable) : mise à jour automatiquement quand vous ouvrez le fichier.
• Heure (fixe).
• Heure (variable) : mise à jour automatiquement quand vous ouvrez le fichier.
• Auteur : nom et prénom renseignés dans les données de l’utilisateur de LibreOffice.
• Numéro et/ou nombre de pages (numéro et/ou nombre de diapos).
• Nom de fichier.
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Conseils
Pour modifier les informations sur l’auteur, allez à  Outils > Options > LibreOffice >
Données d’identité.
Pour changer le format du champ numéro de page (1,2,3 ou a, b, c ou i, ii, iii, etc.) allez
à  Diapo > Propriétés de la page/diapo,  onglet  Page,  puis  sélectionnez le  format
désiré à partir de la liste Format dans la zone Paramètres de mise en page.
Pour modifier le style du paragraphe dans toute votre présentation, ouvrez la boîte de
dialogue Styles et formatage et modifier le style de présentation désiré.

Ajouter des commentaires à une présentation

Impress autorise des commentaires semblables à ceux de Writer ou Calc.

Dans la vue Normale, allez à  Insertion > Commentaire dans la barre de menu pour ouvrir un
commentaire vide (Figure 32). Une petite boîte contenant vos initiales apparaît dans le coin supé-
rieur gauche de la diapositive accompagnée d’un cadre de texte plus large. Impress ajoute auto-
matiquement votre nom et la date courante dans le bas du cadre.

Figure 32 : Insérer des commentaires

Saisissez ou collez votre commentaire dans le cadre de texte. Vous pouvez lui appliquer quelques
formatages de base : sélectionnez le texte, faites un clic droit et faites votre choix dans le menu
contextuel. Ce menu vous permet d’appliquer une mise en forme au texte sélectionné, de suppri-
mer le commentaire courant, tous les commentaires du même auteur ou tous les commentaires de
la présentation.

Vous pouvez déplacer les petites marques de commentaires où vous voulez sur la diapositive.
Vous les placerez sûrement près de l’objet auquel elle se rapporte.

Pour afficher ou masquer les commentaires, cliquez sur Affichage > Commentaires dans le menu
principal.

Utiliser Outils > Options > LibreOffice > Données d’identité pour définir le nom qui apparaîtra
dans les commentaires.

Si plusieurs personnes modifient le document, chaque auteur recevra automatiquement une cou-
leur de fond propre pour ses commentaires.

Paramétrer le diaporama

Comme mentionné au paragraphe «Modifier le diaporama » à la page  24, Impress affecte des
paramètres par défaut judicieux, mais vous autorise à personnaliser de nombreux aspects de votre
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diaporama. Cette section ne propose que quelques-uns des réglages possibles ; les techniques
avancées sont expliquées au Chapitre 9 Diaporama du Guide Impress.

La plupart des tâches se feront en mode trieuse de diapositives où vous pourrez visualiser l’en-
semble des diapositives simultanément. Choisissez Affichage > Trieuse de Diapos dans la barre
des menus ou cliquez sur l’onglet Trieuse de Diapositives en haut de l’espace de travail.

Un ensemble de diapos, plusieurs présentations
Dans beaucoup de cas, vous trouverez peut-être que vous avez trop de diapositives pour le temps
dont  vous disposez pour  les  présenter  ou vous voudrez  en offrir  un survol  rapide sans vous
étendre sur les détails. Plutôt que d’avoir à créer une nouvelle présentation, vous pouvez utiliser
deux outils mis à votre disposition par Impress : le masquage de diapositives et les diaporamas
personnalisés.

Masquer des diapositives
 1) Sélectionnez la diapositive que vous voulez masquer dans le Volet Diapo ou la vue Trieuse

de diapos sur l’Espace de travail.
 2) Allez à  Diapo > Masquer la diapo sans la barre de menu ou faites un clic droit sur la

vignette de la diapo et choisissez Masquer la diapo dans le menu contextuel. Les diaposi-
tives masquées sont marquées de hachures grises.

Diaporamas personnalisés
Si vous désirez créer un diaporama personnalisé à partir de la même présentation :

 1) Sélectionnez les diapositives que vous voulez utiliser dans le diaporama personnalisé.
 2) Allez à Diaporama > Diaporama personnalisé sur la barre de menu.
 3) Cliquez sur le bouton Nouveau pour créer une nouvelle suite de diapositives et l’enregis-

trer sous un nom différent. Vous pouvez créer autant de diaporama que vous voulez à par-
tir d’une présentation unique.

Transitions entre diapositives
Une transition de diapositive est l’animation jouée lors du changement de diapositives de la pré-
sentation. Vous pouvez configurer la transition à partir du panneau Transition du volet latéral.

 1) Allez à Diapo > Transition dans la barre de menu ou cliquez sur l’icône Transition 
du volet latéral pour ouvrir le panneau qui propose les options de transitions.

 2) Sélectionnez la transition souhaitée, la vitesse de l’animation, choisissez si vous souhaitez
passer à la diapo suivante sur un clic de l’utilisateur ou si le déclenchement est automa-
tique et chronométré.

 3) Cliquez sur Appliquer à toutes les diapos, à moins que vous ne préfériez varier les transi-
tions au long de la présentation.

Conseil
Le panneau Transition propose une option très utile :  Aperçu automatique. Cochez
l’option et à chaque changement de transition, la diapositive apparaîtra dans l’espace
de travail avec le nouvel effet de transition.

Déroulement automatique des diapositives
Vous pouvez régler la présentation pour passer automatiquement à la diapositive suivante après
un délai défini dans le panneau Transition du volet latéral.

 1) Allez à la section Passer à la diapo suivante et sélectionnez Automatiquement après.
 2) Définissez la durée d’affichage de chaque diapositive en secondes.
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 3) Cliquez sur le bouton  Appliquer à toutes les diapos pour appliquer les mêmes para-
mètres à toutes les diapositives.

Pour appliquer un temps d’affichage différent à chaque diapositive de votre présentation :

 1) Allez à Diaporama > Présentation chronométrée dans la barre de menu pour démarrer
le diaporama. La première diapo s’affiche avec un chronomètre dans le coin inférieur.

 2) Cliquez sur le chronomètre lorsqu’il est temps de passer à la diapo suivante. Pour conser-
ver le réglage par défaut pour cette diapo, cliquez sur la diapo, mais pas sur le chrono-
mètre. Continuez ainsi pour toutes les diapos de votre présentation.

 3) LibreOffice a enregistré la durée d’affichage de chaque diapo. Enregistrez la présentation.

Pour recommencer un diaporama après l’affichage de la dernière diapositive :

 1) allez sur Diaporama > Paramètres du diaporama. 
 2) Sélectionnez Auto pour le type et le délai de pause entre diaporamas.
 3) Cliquer OK quand vous avez terminé.

Jouer un diaporama
Pour jouer un diaporama, choisissez l’une des méthodes suivantes :

• Sélectionnez Diaporama > Démarrer à la première diapo sur la barre des menus.

• Cliquez l’icône Démarrer à la première diapo  sur la barre d’outils Standard.

• Appuyez sur la touche F5 du clavier.

Si la transition du diaporama est configurée sur Automatiquement après x secondes, laisser le dia-
porama se dérouler de lui-même.

Si la transition est configurée sur Au clic, faites comme suit pour passer à la diapositive suivante :

• Utilisez les touches directionnelles du clavier (flèche droite, flèche gauche) pour passer à la
diapo suivante ou revenir à la précédente.

• Cliquez avec la souris pour atteindre la diapositive suivante.
• Appuyez sur la touche espace du clavier pour avancer à la diapo suivante.
• Tournez la molette de la souris.

Faites un clic droit n’importe où pour ouvrir un menu contextuel à partir duquel vous pouvez navi-
guer entre les diapositives et régler d’autres options. 

Pour quitter le diaporama à n’importe quel moment, appuyez sur la touche Échap.

Console de présentation
LibreOffice dispose d’une Console de Présentation (Figure 33) qui peut être utilisée quand un dis-
positif d’affichage supplémentaire a été connecté à votre ordinateur. Celle-ci offre un contrôle sup-
plémentaire sur le diaporama en proposant des vues différentes sur l’écran de votre ordinateur et
sur le dispositif d’affichage que voit l’auditoire. Celle que vous voyez sur votre écran comporte la
diapositive courante, la suivante, les notes de la diapositive et un chronomètre.

Pour  plus d’informations et  de détails  sur l’utilisation de la  Console de Présentation,  voyez le
Guide Impress, Chapitre 9, Diaporamas.

Contrôle à distance d’Impress

LibreOffice Impress Remote vous permet de contrôler une présentation avec un dispositif mobile. Il
s’agit d’un logiciel pour smartphone développé par la communauté pour les systèmes Android et
IOs qui vous évite de rester à proximité de votre ordinateur pendant l’exécution d’un diaporama
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avec Impress. Vous pouvez ainsi utiliser votre téléphone mobile ou votre tablette pour parcourir
vos diapositives en direct.

Figure 33 : La console de présentation d'Impress

La connexion entre votre mobile et l’ordinateur où s’exécute votre présentation est réalisé par un
couplage Bluetooth ou une liaison à un réseau local commun aux deux appareils.

Obtenir Impress Remote
Pour obtenir le logiciel, allez au dépôt d’applications de votre mobile, soit Google Play Store pour
les appareils sous Android, soit Apple Store pour les appareils sous IOs. Recherchez « Impress
Remote » et, parmi tous les résultats, choisissez celui qui provient de The Document Foundation
et installez-le sur votre appareil.

Connecter l’appareil mobile à l’ordinateur

Connexions Bluetooth
Activez la liaison Bluetooth sur les deux appareils. Reportez-vous à la documentation de votre
appareil mobile et du système d’exploitation de votre ordinateur pour la façon d’activer et de confi-
gurer un identifiant Bluetooth. Procédez ensuite au couplage des deux dispositifs Bluetooth. Une
fois encore, reportez-vous à la documentation de chaque appareil pour le paramétrage de la liai-
son Bluetooth.

Une fois le couplage établi, votre dispositif mobile est prêt à contrôler votre présentation.

Autoriser le contrôle à distance dans Impress
Le contrôle à distance des diaporamas d’Impress n’est pas activé par défaut. Pour cela, sélection-
nez le menu Outils > Options > LibreOffice Impress > Général et cochez Activer le contrôle à
distance dans la zone Présentation du dialogue(Figure 34).
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Figure 34 : Activer le contrôle à distance dans Impress

Exécuter un diaporama avec Impress Remote

Voici les simples étapes à effectuer :

• Assurez-vous que le Bluetooth est déjà activé et configuré sur les deux appareils.
• Sur votre ordinateur, ouvrez la présentation que vous désirez exécuter.
• Sur votre téléphone :

– Ouvrez Impress Remote à partir du menu principal (Figure 35).
– Pour sélectionner votre ordinateur, tapez son nom. La présentation ouverte sur l’ordina-

teur démarre automatiquement (Figure 36 et Figure 37).
– Pour avancer dans la présentation, tapez sur la vignette de la diapositive ou utilisez le

bouton matériel de hausse du volume du téléphone.
– Pour reculer dans la présentation, tapez deux fois sur la vignette de la diapositive ou

utilisez le bouton matériel de baisse du volume du téléphone.
– Pour ignorer les transitions et les animations d’une diapositive, faîtes un glissé vers la

gauche pour aller à la diapo suivante ou vers la droite pour aller en arrière.
– Pour terminer la présentation, utiliser le bouton arrière du téléphone ou ouvrez le menu

et sélectionnez Arrêter le diaporama.
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Figure 35 : Périphériques 
Bluetooth visibles

Figure 36 : Une présentation 
vue dans Impress Remote

Figure 37 : L'ensemble des 
diapositives dans Impress 
Remote
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